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Overview: This tutorial will enable users to acquire, process, and analyze NASA Earth observation data for urban 
heat mitigation. The tutorial will focus on Boynton Beach, Florida as a case study; however, the same 
methodologies can be applied to other projects focusing on the urban heat island (UHI) effect. 
 
This tutorial aims to explain the GIS processes and methodology involved in the Boynton Beach Health & Air 
Quality project. The tutorial first includes instructions for creating daytime and nighttime UHI maps, using thermal 
bands from Landsat 8 Thermal Infrared Sensor (TIRS) and Landsat 9 TIRS-2. Second, this tutorial outlines how to 
generate a heat vulnerability index map, which combines UHI data with asthma data to reveal areas more vulnerable 
to heat stress. Additionally, this tutorial provides instructions for albedo maps, which depict surface reflectance and 
a bivariate of albedo and energy expenditure to examine a correlation between reflectance and energy use. Two 
types of vegetation maps are also covered: tree canopy and Normalized Difference Vegetation Index (NDVI) using 
aerial imagery from the National Agricultural Imagery Program (NAIP) as well satellite imagery from and Landsat 8 
Operational Land Imager (OLI) and Landsat 9 OLI-2. Finally, we used ECOSTRESS to create an 
evapotranspiration map to depict the amount of moisture being released into the air. Being able to replicate and 
improve on our original maps will help the partners as their environmental and policy circumstances change. They 
may need to revisit the data and adjust results based off future decision-making processes, and this tutorial will 
provide a useful guide to the partners.  
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Set up & Requirements 
 

ArcGIS Pro Version 3.4.0 
To use ArcGIS Pro, follow the tutorial to download ArcGIS Pro and create an account.[1] Make sure you have the 
appropriate licenses to use ArcGIS Pro. We used the Advanced ArcGIS Pro license and used the 3D analyst, 
geostatistical analyst, and spatial analyst extensions. 
 

USGS – Earth Explorer 
To access NASA Earth observation data and imagery, create an account with USGS EarthExplorer at 
https://earthexplorer.usgs.gov/.[2] EarthExplorer provides access to imagery from Landsat 8 and 9 satellites, which 
we used to generate maps of land surface temperature (LST), albedo, and NDVI. EarthExplorer also contains 
NAIP data which was used for mapping tree canopy.  
 

NASA – AppEEARS 
To access and process ECOSTRESS data, create an account with NASA’s Application for Extracting and Exploring 
Analysis Ready Samples (AppEEARS) at https://appeears.earthdatacloud.nasa.gov/.[3] AppEEARS allows users to 
request and download analysis-ready datasets from a variety of NASA Earth science products. We used AppEEARS 
to obtain ECOSTRESS evapotranspiration and nighttime LST data. AppEEARS streamlines data processing by 
allowing users to clip and reproject data to their area of interest. 
 

Methods 
 

1. Data Acquisition and Processing 
1.1 Study and Reference Area Shapefile 
We created shapefiles for both our study area and our reference area to perform further analysis. The reference area 
shapefiles were created primarily for our heat analyses.  
 

1. Open a new project in ArcGIS Pro. 
 

2. Go to the Catalog pane. Under the Project tab, click Databases and right-click on the geodatabase for the 
project you are working on. 

 
3. Select New → Feature Class. Name the file after the study or reference area for your project. Ensure that 

the Feature Class type is set to “Polygon.”  
 

4. Select Finish. In your contents pane, a new feature class should appear with the name of your shapefile. 
 

5. On the Edit tab on the ribbon, click Create and select the feature class you just made. A variety of tools for 
creating and modifying shapefiles will appear in the Create Features pane. 

 
6. Ensure that the first tool (Polygon) is selected:  

 

https://pro.arcgis.com/en/pro-app/latest/get-started/download-arcgis-pro.htm
https://earthexplorer.usgs.gov/
https://appeears.earthdatacloud.nasa.gov/
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7. In your Map, zoom to the location of your reference area and click to place points around the          
boundary. Double-click on the first point you created to finish drawing the polygon. Click Finish. 
 

8. To change the format of your polygon, select the symbol under your feature class in the Contents pane.  
 
9. Within your project folder, create a new folder called “ReferenceArea” or “StudyArea.” Export your feature 

class by right-clicking it in the Contents pane and selecting Data → Export Features. 
 
10. Select the folder next to Output Feature Class and navigate to the ReferenceArea or StudyArea 

folder in your project folder. This will save your shapefile so you can use it in other maps.  
 

1.2 Acquiring Landsat Data from EarthExplorer 
We used Landsat data to create maps displaying the UHI effect, NDVI, and albedo.  
 

1. On the USGS EarthExplorer website, sign in or create an account if you have not already done so.[2] 
 
2. In the Search Criteria tab, select the Polygon tab to define your area of interest. Set your area of interest by 

zooming to your study area on the map and draw a polygon by clicking to select points. For our project, we 
drew a quick polygon around the Boynton Beach area. Another way to define your area of interest is by 
uploading a zipped file into the KML/Shapefile Upload tab.  
 

 
 
 
 
 
 
 
 
 
 
 

 
3. In the Date Range, set the time period of your study.  

 
4. In the Cloud Cover, set the Cloud Cover Range to 25%.  

 
5. In the Data Sets tab, select Landsat. Depending on what is being calculated, different levels will be used:  

a. UHI and NDVI 
Select Landsat Collection 2 Level-2 → Landsat 8-9 OLI/TIRS C2 L2. Select Results. 

b. Albedo 
Select Landsat Collection 2 Level-1 → Landsat 8-9 OLI/TIRS C2 L1. Select Results. 

 

https://earthexplorer.usgs.gov/
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6. In the Results tab, all available scenes will appear for your set parameters. Click the 
Footprint to ensure that your study area is within the scene.  
  

 
 
 
 

7. To download data, select the Download Options icon and select Product Options. Download the Product 
Bundle at the top. This will download GeoTIFF files for all the bands needed for daytime UHI, NDVI, and 
albedo analyses.  

 

1.3 Acquiring NAIP Data from EarthExplorer 
We acquired NAIP data to perform an analysis on tree canopy coverage in our study area.  
 
1. On the USGS EarthExplorer website, sign in or create an account if you have not already done so. 

 
2. In the Search Criteria tab, select KML/Shapefile Upload. This is another way to define your area of interest 

and is especially helpful with NAIP data because it minimizes the results to your specific study area. In the 
dropdown, change the upload from KML/KMZ to Shapefile. Upload a zipped file of the study area shapefile 
created in 1.1 Study and Reference Area Shapefile. Below is an example of the shapefile we uploaded of 
Boynton Beach.  

Basemaps credits: NASA–ESRI EULA 
 

3. In the Date Range, set the time period of your study. Cloud cover does not need to be set for NAIP data.  
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4. In the Data Sets tab, select Aerial Imagery → NAIP. 

 
5. Select the Results tab, all available scenes will appear for your set parameters. Six 

images are available for each year for the Boynton Beach area, but only four need 
to be downloaded for analysis. Click on the footprint to view each scene and 
ensure that the entire study area is covered, as shown on the right. 

 

 

 
6. To download NAIP data, click the Download Options icon and download the 

Full Resolution image for each set of data that covers your study area. 
  

1.4 Acquiring ISS ECOSTRESS Data from NASA AppEEARS 
We used ISS ECOSTRESS to calculate the nighttime UHI effect and to create an evapotranspiration map.  
 

1. On the NASA AppEEARS website, select Sign In on the top right and log in to Earthdata. 
 

2. Select Extract → Area. Start a new request. Name your sample “LST” or “Evapotranspiration” depending 
on what you are requesting.  

 
3. Input your study area by uploading your zipped shapefile in the polygon. To calculate the UHI effect, you will 

need to make a separate request to extract the reference area as well. Select the dates for your study period. 
Your study area or period may need to be broken up into separate requests if the download size exceeds the 
maximum allowed.  

4. Select the layers to include in your extract depending on what you are calculating:  
a. UHI  

Footprint 
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When selecting layers, search ECOSTRESS and select ECOSTRESS Land Surface Temperature 
and Emissivity (LST&E). Scroll down and add the SDS_LST layer. Search ECOSTRESS again 
and select ECOSTRESS Cloud Mask. Add the SDS_CloudMask layer.   

 
b. Evapotranspiration  

Search ECOSTRESS and select ECOSTRESS Evapotranspiration PT-JPL. Add the 
EVAPOTRANSPIRATION_PT_JPL_ETdaily layer. This is the layer with evapotranspiration 
(ET) data. Search ECOSTRESS again and select ECOSTRESS L3/L4 Ancillary Data Quality 
Assurance (QA) Flags. Add the L3_L4_QA_ECOSTRESS_L2_QC layer. This is the quality 
control layer used to filter out the good pixels for further analysis.  

 
 

 
 
 

5. Under Output Options, leave the File 
Format as a GeoTiff. In the Projection section, 
select Geographic and select Submit.  
 

6. Select Explore to view your request. The time it takes for a request to be filled depends on how big of a 
request it is. You will receive an email when the request has been fulfilled.   

 
7. After receiving the email, navigate back to the Explore requests page. The Status for your request should be 

listed as Done.  

 
8. Select the Download button. This will bring you to the Download Area Sample page. Select the box to 

download all of the files on the left, or select the files you need.  
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9. After selecting all of your desired files, click the Download dropdown and select Download Files.  

 
10. Once the download is complete, you can find the files in your downloads folder.  

 

1.5 Cloud Mask (Landsat) 
Clouds obstruct the view of Earth’s surface and interfere with Landsat’s data collection. When clouds block the 
sensors, temperature may appear cooler than it actually is. For this reason, we performed a cloud mask on the 
Landsat data for our daytime UHI and albedo analyses.  
 

1. In ArcGIS Pro, open your project. Select View in the ribbon and open the Catalog pane. In the Computer 
tab, navigate to where your Landsat Product Bundle was saved.  
 

2. Drag the QA_PIXEL band from the Catalog to the Contents pane to add it to the map.   
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3. Right-click the band and select Symbology. Under Primary symbology, select the dropdown menu to 
change it from Stretch to Unique Values. Select Yes when the warning box appears to build an attribute 
table. The image on the right is what the map should somewhat look like after changing the symbology.  

 
4. Select View in the ribbon and open the Geoprocessing pane. Search for the Con tool and open it. In Input 

conditional raster, select the QA_PIXEL layer of your dataset. In the Expression section, add the 
parameters where Value is equal to 21824 or Value is equal to 21952. This will ensure that only pixels clear 
of clouds will be kept. In Input true raster or constant value, select the raster layer based on what you are 
calculating:  

a. Daytime UHI: Select Band 10.  
b. Albedo: Select the composite image you created in Step 6 of Basemaps credits: NASA–ESRI EULA 

 

c. 2.3 Albedo. 
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5. Input false raster or constant value can be left blank. In Output raster, name the new cloud-masked layer. 
In the example below, a cloud mask was performed for a daytime UHI analysis. 

 
6. Select Run. This is what the cloud-masked image should look like.  

Basemaps credits: NASA–ESRI EULA 
 

1.6 Unit Conversion, Extracting Polygons, and Calculating the Median for UHI 
For our daytime UHI analysis, we performed these processing steps after cloud masking the entire scene each day. 
This ensured that the data were ready to make a composite image.  
 
a. Unit Conversion 
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1. After cloud masking the Landsat data, the units will be in Scaled Kelvin. A unit conversion will be performed 
to convert these values to Celsius. In the Geoprocessing pane, open the Raster Calculator tool. In “Band 
10,” insert your cloud-masked data. After typing out your equation, select Run.  

 

(("Band 10" ⋅  0.00341802) + 149.0) − 273.15 

 
2. A new raster layer will be created in your Contents pane with the same data in Celsius. An example of the 

Raster Calculator calculation and the before and after of the conversion is shown below.  

 
b. Extracting Polygons 

1. To extract your study area and reference area, open the Geoprocessing pane and open the Extract by Mask 
tool. 
 

2. In Input raster, select the data that were converted to Celsius. In Input raster or feature mask data, select 
the shapefile of the study area or reference area. The tool will need to be used twice to extract both areas. 
In Output raster, you can name your layer.  

 

 
 

3. Select Run. An example is shown below of our extracted study area and reference area. 
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Basemaps credits: NASA–ESRI EULA 

 
c. Calculating the Median of Reference Area 

1. The median value of the reference needs to be taken for the UHI effect calculation. In the Geoprocessing 
pane, search for and open the Zonal Statistics tool.   
 

2. In Input Raster or Feature Zone Data, select the shapefile of your reference area. 
In Input Value Raster, select the raster layer of the data for your reference area. 
You can name this layer under Output Raster. Under Statistic Type, select the 
dropdown and change it from Mean to Median.  

 
3. A new layer will be created with a value showing the median of the reference area.  

 

1.7 Filtering, Quality Control, Cloud Mask, and Unit Conversion (ECOSTRESS)  
To create the nighttime UHI effect and evapotranspiration maps, we performed these steps to prepare the data for 
further analysis.  
 
a. Filtering 

1. We began by applying a filtering script in Python to remove extreme or nonphysical pixel values from LST 
and latent heat flux (LE) datasets. This involved removing: 

a. Pixels with LST values outside the expected ranges for Florida’s climate (60–160°F) 
b. ET pixels with a value of zero or missing due to incomplete satellite retrievals or persistent cloud 

cover 
c. Saturated or an inconsistently high/low pixel values based on outlier detection 

 
a. Quality Control (QC) 

1. To filter out pixels with low-quality data for our analysis, we used a separate Python 3.13.1 script to apply 
pixel-level quality control using: 

a. The ECOSTRESS SDS_QC layer for LST 
b. The ECOSTRESS L3/L4 QC flag layer for ET 
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More details on ECOSTRESS QC filtering can be found at 
https://ecostress.jpl.nasa.gov/downloads/tutorials/Applying_QC_Flags.pdf.[4] 

 
2. The SDS_QC layer should be automatically applied when you acquire the cloud mask and LST layers from 

NASA AppEEARS. 
 

3. The scripts filtered out any pixel flagged with retrieval errors, low confidence, or missing values based on 
ECOSTRESS documentation. 

 
4. The pixels that passed these quality assurance checks were retained for unit conversion and spatial analysis. 

 
b. Cloud Mask 

1. Cloud masking was applied to LST products only. ECOSTRESS ET data did not have a dedicated cloud mask 
band and solely relied on QC filtering.  
 

2. For the LST data, we used a script in Python to read the SDS_CloudMask layer and retain only pixels flagged 
as clear sky. 

 
3. Pixels flagged as cloudy, cloud shadow, or uncertain were excluded using bitwise operations and conditional 

masking logic. 
 

4. The resultant LST rasters were exported as GeoTIFFs and imported into ArcGIS Pro for mapping and UHI 
analysis. 

 
c. Unit Conversion 

1. During the quality control step, the ECOSTRESS data were converted into physical units, though it can also 
be done in ArcGIS Pro following the steps in 1.6.  

a. LST was rescaled and converted from Kelvin to degrees Celsius using the equation: 
 

𝐿𝑆𝑇𝐶𝑒𝑙𝑠𝑖𝑢𝑠  =  (𝐿𝑆𝑇  ⋅  0.02)  −  273.15 
 

b. ET was derived from LE and turned into mm/day using the Penman-Monteith relationship: 
 

𝐸𝑇  =
𝐿𝐸

𝜆
 

 
Where λ (latent heat of vaporization) is 2.45 MJ/kg.[5] 

 

1.8 Acquiring CDC Health Data from the ArcGIS Online Portal 
Health data were acquired to perform a further analysis comparing a health metric with urban heat. These data were 
used to create a heat vulnerability index.  

https://ecostress.jpl.nasa.gov/downloads/tutorials/Applying_QC_Flags.pdf
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1. In ArcGIS Pro, open your project. In the View tab, open the Catalog pane. Select Portal. In the search bar, 
search PLACES. 

 
2. Right-click PLACES: Local Data for Better Health and select Add to Current Map.  

 
3. To clip this data to your study area, open the Geoprocessing pane and select the Clip tool.  

 

 
 

4. In Input Features or Dataset, select Tracts. In Clip Features, select the shapefile of your study area. Lastly, 
name the new feature layer in Output Features or Dataset.  
 

5. Select Run. A new layer will be created in your Contents pane with the clipped health data.  
 

1.9 Acquiring Energy Data from LEAD 
For our analysis, we acquired energy data to analyze the relationship between albedo and energy cost.  
 

1. To acquire energy data, navigate to the Low-income Energy Affordability Data Tool (LEAD) to mine and 
download data.[6]  

https://www.energy.gov/indianenergy/low-income-energy-affordability-data-lead-tool
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2. After locating the desired data and filtering by location and census tracts, import a data table with the 
average annual energy cost into ArcGIS Pro.  
 

3. To clip this data to your study area, open the Geoprocessing pane and select the Clip tool.  
 

 
 

4. In Input Features or Dataset, select Tracts. In Clip Features, select the shapefile of your study area. Lastly, 
name the new feature layer in Output Features or Dataset.  
 

5. Select Run. A new layer will be created in your Contents pane with the clipped energy data. 
 

2. Data Analysis 
2.1 Composite Daytime UHI 
After performing the processing steps for each day in our study period, we created a composite image combining all 
these days for our analysis. Our study was split into two periods: 2013–2019 and 2020–2024, so two composite 
images were created for daytime UHI.  

 
1. After processing Landsat data, the UHI effect can be calculated using the following formula:  

 

𝑈𝐻𝐼 = 𝑇𝑆𝑡𝑢𝑑𝑦 𝐴𝑟𝑒𝑎 − 𝑇𝑅𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒 𝐴𝑟𝑒𝑎 

 
2. In the Geoprocessing pane, open the Raster Calculator tool. Select the extracted study area LST map and 

subtract the median value of the reference area, which was calculated in 1.6 Unit Conversion, Extracting 
Polygons, and Calculating the Median for UHI. 
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3. For our analysis, the UHI effect (along with each processing step) was calculated for every available day in 
our study periods (2013–2019, 2020–2024) during the hottest months (July 1st to September 30th). 
 

4. After compiling all of the UHI data, a composite image was created combining each day in our study period 
by taking the median value of each pixel. In the Geoprocessing pane, open the Cell Statistics tool.  
 

5. In Input rasters or constant values, select all the calculated UHI layers in your study period. In Output 
raster, name your new composite layer. In Overlay statistic, change the statistic from Mean to Median.  

 
 

6. Select Run. This will produce a composite image of the median UHI value of each pixel in the study area.  
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Basemaps credits: NASA–ESRI EULA 

 

2.2 Composite Nighttime UHI 
Similarly to our daytime UHI analysis, we created a composite image displaying nighttime UHI for comparison.  

 

1. After the ECOSTRESS data are processed, the UHI effect can be calculated using the same formula used in 2. 
Data Analysis 

2. 2.1 Composite Daytime UHI.  
 

3. In the Geoprocessing pane, open the Raster Calculator tool. Select the extracted study area LST map and 
subtract the median value of the reference area, calculated in 1.6 Unit Conversion, Extracting Polygons, and 
Calculating the Median for UHI. 
 

4. For our nighttime analysis, we calculated the UHI effect for each available day from 2018–2024 during the 
hottest months (July 1st to September 30th).  
 

5. A composite image was created from the median value of each pixel from each day in the study period, 
similarly to the daytime analysis. In the Geoprocessing pane, open the Cell Statistics tool.  
 

6. In Input rasters or constant values, select the calculated UHI data for each day in your study period. In 
Output raster, name your new composite layer. Change the Overlay statistic from Mean to Median. 
 

7. Select Run. This is the composite nighttime UHI map. An example of ours is shown below.  
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Basemaps credits: NASA–ESRI EULA 

 

2.3 Albedo 
We created maps displaying albedo to analyze the differences in reflectance in urban and surrounding areas. 

 
1. Import the data into ArcGIS pro and save, separating by year (2014 and 2024). 

 
2. To measure albedo, first calculate top of atmosphere (TOA) in the Raster Calculator geoprocessing tool. 

The variables are reflectance multi band value (M), raster band (Q), reflectance add band value (A), and sun 
elevation angle (SE), which can be found in the XML file of the respective product bundle.  

 

 
 

3. To convert the SE value from degrees to radians before plugging into the equation, find a degree to radian 
conversion tool online and use the radian value for the equation listed below. Repeat this step for bands 
2,4,5,6,7 for each individual day of interest. 

𝑇𝑂𝐴  =  
(𝑀𝑄 + 𝐴)

sin(𝑆𝐸)
 

4. After calculating the TOA value for each desired day, we used the following equation to calculate albedo: [7] 
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𝐴𝑙𝑏𝑒𝑑𝑜  =  
(0.365(𝑏2) + 0.130(𝑏4) + 0.373(𝑏5) + 0.085(𝑏6) + 0.072(𝑏7) − 0.0018)

1.016
 

 
5. Using the raster calculator geoprocessing tool, plug in each TOA value for the bands of interest (2,4,5,6,7) 

into the above equation.  
 

6. After retrieving the albedo for each day, use the cell statistics geoprocessing tool to create a composite image. 
Select each desired day for that season and select median for the calculation. 
 

7. Refer to Section 1.5 Cloud Mas to cloud mask this composite data.  
 

8. After combining the yearly data, navigate to symbology and switch the stretch type to minimum maximum. 
  

2.4. NDVI  
NDVI depicts the health and density of vegetation. It is important to consider when examining heat because 
vegetation often has a direct correlation with land surface temperature. In our team’s results, we found that areas 
with healthier and denser vegetation often had the coolest land surface temperatures.  

 
1. To add the data in Arc Pro, open the file and select the two file names that end with “B4” and “B5”. You are 

selecting for bands 4 and 5, which is how to calculate NDVI. You can also rename these files for convenience 
(2023_09_08_B5) 

 
 

2. To calculate NDVI, open the raster calculate geoprocessing tool. The equation is as follows: [8] 
 

𝑁𝐷𝑉𝐼  =  
𝐹𝑙𝑜𝑎𝑡(𝐵𝑎𝑛𝑑5  −  𝐵𝑎𝑛𝑑4)

𝐹𝑙𝑜𝑎𝑡(𝐵𝑎𝑛𝑑5  +  𝐵𝑎𝑛𝑑4)
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3. Once the NDVI is calculated for the day, repeat this process for all the days you would like to use for the 
year.   

 
4. Use the Cell Statistics Geoprocessing tool to take the maximum of all the NDVI values for the year. There 

will be more days in your version, this image only shows one day. 
 

 
 

5. This should provide you with an annual NDVI map. The values should be between -1 and 1. 
 

6. To get the raster in a more digestible format, navigate to the Analysis tab at the top of your screen. Under 
this tab, click Tools, and search for the Clip Raster tool in the geoprocessing window on the right side to 
size the raster to your study area, and change the symbology to a green color gradient. 
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7. Repeat this process for each year, and to get a 5-year map, use the Cell Statistics tool again. Upload all 5 
NDVI maps and take the median of them. Select Run. This will provide the final NDVI map! 

Basemaps credits: NASA–ESRI EULA 
 

2.5 Tree Canopy  
Tree Canopy is essential when breaking down the different factors of heat and LST. Our team’s results found that 
tree canopy and shade were often associated with the coolest daytime land surface temperatures.  

 
1. In EarthExplorer, under datasets and aerial imagery, select NAIP. Download the files that encompass your 

study area and unzip them. For Boynton Beach, there were 6 separate images that encompassed the city. 
 

2. Upload into ArcGIS Pro (rename the files if desired) and use the Mosaic to New Raster tool to combine 
images from the same day, as shown in the image below. This will combine all 6 images into one raster. Make 
sure to double check the pixel type (8 bit unassigned) and check there are 4 bands. 
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3. Clip the new raster to the parameters of Boynton Beach using the Clip Raster tool. That way only the data in 
Boynton Beach are processed.  
 

4. Start classifying tree canopy by opening the ISO Cluster Unsupervised Classification tool. Upload the 
clipped raster file into the tool, and select the number of classes you are interested in. Even if eventually you 
only want two classes (tree and non-tree), it is best to start with a larger number and classify them yourself for 
better accuracy. For this project, we started with twenty classes. 
 

 
 

5. After running this tool, the result should be a very colorful map with 20 color classes ranging from 1 to 20. 
Zoom in, click around, and see if there are any classes that you can identify as tree or not tree. If there is a 
class that looks like it is comprised of roads or buildings, set it to grey and change the label to indicate what it 
is. 

   
 

6. If there are classes mixed between trees and non-tree values (grass or shadow), you can perform a “cluster 
bust” to further sort them. This will re-classify a single class into 10 more sub-classes. There are a few steps 
needed to do this. First, identify which class you would like to re-sort. Then, use the Con tool to make a new 
layer with only this class. Set the value equal to the class number, and the input true raster equal to 1.     



 
 

 

23 
 

   
 

7. Next run a tool called Extract by Mask, which prepares the new layer to be re-sorted.  

 
8. Now, it is time to re-classify the class. Run another ISO Unsupervised cluster, but this time you only need to 

make ten new classes. After this is created, again identify each sub-class as tree or not tree. 
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9. Now there should be two or more layers of classifications for tree and not tree. To make these layers you will 
need to convert them to Boolean values (true or false) by creating a binary. To do this, open the Reclassify 
geoprocessing tool, and reassign the values assigned tree or not tree with 1 or 0. 
 

 
 

10. There should now be two or more (however many classes needed to be re-sorted) binary layers. You will need 
to combine these to get the most accurate data and perform overall calculations. To do this, open the Mosaic 
to New Raster geoprocessing tool. Make sure the pixel type and number of bands are correct. Input the 
cluster bust layer first, and then the larger classification layer. Then, at the bottom, make sure to select First 
for the mosaic operator. 
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11. Now your final tree canopy map is done! To perform calculations about total tree canopy cover, it may be 
easier to do in Excel. Open the attribute table for your tree canopy layer and look at the values. It should look 
simple with only two rows and look something like this: 
 

 

12. In Excel, calculate the count of the trees divided by the total count of pixels. For this example, it would look 
like (480135150 / (480135150 + 119163157)). This is used to calculate percent tree canopy by pixel.  
 

13. If desired, the accuracy of this percentage can be determined by performing a confusion matrix.  
 

2.6 Evapotranspiration 
Evapotranspiration is a measurement of water moving from the Earth’s surface and from plants into the 
atmosphere. We created a map displaying this in our study area to compare it with our vegetation maps.  

 
1. Import the evapotranspiration data into ArcGIS Pro. 

 
2. Compile each season’s data of evapotranspiration, adding all data into a single map. 

 
3. To create a median composite map over the specified period, navigate to the Analysis tab. Under analysis, 

click on Tools. In the Find tools search bar, search for the Cell Statistics geoprocessing tool. Ensure that 
you select the Spatial Analyst tool version. 
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4. Select each desired year under Input Rasters. For our project we compiled data from 2021 and 2022. Name 
the output raster MedianCompositeEvapotranspiration. Select Median for the overlay statistic and click 
run. 

 
5. The resulting map will produce the median composite of all desired years of data for evapotranspiration.  
 

2.7 Heat Hot Spot Analysis 
1. Place calculated albedo, evapotranspiration, and tree canopy composite data from their most recent year into 

a single map. 

 
Basemaps credits: NASA–ESRI EULA 

 
2. Resample the data to create a common coordinate system amongst the indices. 

 
3. Using the project raster data management geoprocessing tool, begin by setting parameters. 

a. Input: dataset that needs to be converted. 
b. Output: dataset that serves as desired coordinate system (e.g., albedo in this project) 
c. Geo transform: accept 
d. Resampling: bilinear interpolation 
e. Output cell size: same dataset as output (e.g., albedo in this project) 
f. XY: accept 

 
4. Navigate to the Environments tab in the Geoprocessing tool 

a. Snap raster: choose the output layer (e.g., albedo in this project) 
 

5. To normalize, open the Raster Calculator tool in the Geoprocessing pane.  
 

6. Use the following equation to normalize albedo, evapotranspiration, and tree canopy data.  
 

𝑥 =
(𝑥 − 𝑥𝑚𝑖𝑛)

(𝑥𝑚𝑎𝑥 − 𝑥𝑚𝑖𝑛)
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7. After normalizing each dataset, combine each of them using the Cell Statistics tool. Select each normalized 
dataset and select median for the overlay statistic. This will create a heat hotspot map with values between 0 
and 1. 
 

2.8 Heat Vulnerability Index 
A bivariate map was created to generate the heat vulnerability index. For this analysis, our study compared crude 
asthma prevalence data with data from our composite daytime UHI analysis. Ensure that the health data are 
imported into ArcGIS Pro (1.8 Acquiring CDC Health Data from the ArcGIS Online Portal).  

 
1. In the View tab, open the Geoprocessing pane and open the Zonal Statistics tool.   

 
2. In Input Raster or Feature Zone Data, select Tracts. In Zone Field, select Census tract FIPS. In Input 

Value Raster, select the composite image of your UHI effect. In Output Raster, name this new layer. 
Finally, change Statistics Type from Mean to Median. This will calculate the median of the UHI data for 
each tract to ensure that it can later be combined with the health metric.  

 

 
 

3. In the Geoprocessing pane, open the Zonal Statistics as Table tool. In Input Raster or Feature Zone 
Data, select the layer you created in the previous step. In Zone Field, select Census tract FIPS. In Input 
Value Raster, select your composite UHI data. In Output Table, name the attribute table that will be 
created. Change the Statistics Type from Mean to Median. Lastly, in Output Join Layer, name the new 
layer that will be created.  
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Basemaps credits: NASA–ESRI EULA 

 
4. Select Run. This will create a new layer in your Contents pane. Right-click the layer and select Symbology. 

In the dropdown, change the Primary Symbology from Single Symbol to Bivariate Colors.  
 

5. In Field 1, select MEDIAN. This was the statistics type with your heat data created in the last step. In Field 
2, select Current asthma crude prevalence (%). This is a health metric to combine the heat data with. We 
changed the Grid Size to 4x4 for our analysis.  

 

 
  

6. This will create a bivariate map comparing crude asthma prevalence and urban heat island effect data.  
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Basemaps credits: NASA–ESRI EULA 

 

2.9 Albedo and Energy Bivariate Map 
The correlation between albedo and annual energy cost is quantified through creating a bivariate map.  

 
1. See section 1.9 to download energy data and import it into ArcGIS Pro.  
 

 
 

2. After importing the above data table, search for census tract data from the desired area of focus.  
 

3. Download the census tract data for the desired area and import into ArcGIS.  
4. Right click on the LEAD Tool Data Census Tracts chart and navigate to joins and relates. Click add join. 

 
5. In the add join tool, make your input table the data table with the annual energy cost data from LEAD. Input 

Tract_ID. Make the join table your Census Tract table. Make the join field Tract_ID again to make this 
the common factor between the two tables. Click okay.  
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6. Name this table TractXEnergy Cost and delete all extra fields except Tract ID and average annual energy cost.  
 

7. To bring in albedo data, locate the Zonal Statistic as Table geoprocessing tool. Input your census tracts as 
the input raster. Make the zone field TRACT_FIPS. Your input raster value should be your albedo data. 
Finally, name your output value albedoXelectricityaverage.  
 

 
 

8. After creating this table, create a join between your tract raster layer and albedoXelectricityavg table using 
the same methods as step 7. This should create a raster layer containing tract, energy cost, and albedo.  
 

9. Navigate to the symbology of the tract raster layer.  
 

10. Select Bivariate Colors as your primary symbology. In Field 1, specify annual energy cost. In Field 2, 
select your albedo data (pictured in the image below as MEDIAN). Choose Quantile as your method.  
 

11. The resulting map should look like the one below.  



 
 

 

31 
 

 
Basemaps credits: NASA–ESRI EULA 
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Conclusion 
 
This tutorial outlined the process for creating and analyzing LST, albedo, evapotranspiration, tree canopy, and 
vegetation health in order to gain a comprehensive overview of the many factors contributing to urban heat. In the 
future, partners can reference this tutorial when using Earth observation data to create similar maps. Having maps 
to visualize these environmental and infrastructural factors makes this data more digestible to a general audience 
and policy makers. Expanding public understanding of the heat challenges facing Boynton Beach is essential for 
collective change. This information and data will help the city when making informed decisions about areas in need 
of more tree canopy and vegetation, alternative cooling methods, and other heat mitigating resources.  
The process of making bivariate maps was also outlined throughout this tutorial. This information provides the City 
of Boynton Beach with data to make informed decisions on potential locations for community cooling centers. 
Moreover, it provides information on identifying areas where heat mitigation efforts may be directed. Overall, this 
step-by-step guide provides the partners with an in-depth tutorial on map recreation to continue assessing urban 
heat and its causative factors in Boynton Beach in the future, allowing them to effectively utilize Earth observations 
for future city planning efforts.  
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